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Introduction

This document describes every menu
option available in Vishwaas Al — both the
Admin Portal and the Data Principal Portal.
For each menu option, it explains what the
section is for and what actions are available
within it, accompanied by a screenshot for

visual reference.

Part 1 covers the Admin Portal, used by
DPOs, Privacy Managers, Grievance Officers,
IT Admins, and other internal staff. Part 2
covers the Data Principal Portal, used by
customers and end users to manage their

own privacy preferences.
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Part 1 — Admin Portal

The Admin Portal is the primary workspace for all internal users of Vishwaas Al It is
accessible at the organisation’s configured Vishwaas Al domain and provides role-based
navigation across all 23 compliance, governance, and configuration modules.

1. Dashboard

o} Vishwaas Al Dashboard

Acme Corporation A 8

5 Consents Compliance Dashboard
© Purpose Catalog eal-time compliance posture across consent, DPR, breach and DPIA workf 0 69 /1 . Generate report
& Not
(=]

© D © 2]
P

100% 5 2 3

Consent Coverage Open DPR Requests Active Breaches Pending DPIAs

R, DataPrincipals Consent Trends DPR Requests by Type
thdrawals — la: breached - avg 15h

B DataMap \
\
& Source Systems \

8 Resolution Rules ® Gra 13 @ With 8 c d: 3

What it is

The Dashboard is the first screen an admin sees after logging in. It provides a real-time
overview of the organisation’s DPDP Act compliance health across all modules in a single

view.

What it does

* Displays the overall Compliance Score as a circular gauge from O to 100,
colour-coded: red (0-40), amber (41-70), green (71-100), with a 7-day trend
indicator.

e Shows total Penalty Exposure in Indian Rupees (crores) based on currently open
compliance gaps, with a breakdown by DPDP Act section and a Resolve deep-link
for each gap.
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Shows key metric cards: Consent Coverage %, open DPR Requests, active Breach
Incidents, and pending DPIAs.

Displays a live activity feed of compliance events across all modules, refreshed every
30 seconds.

Shows real-time CERT-In (6-hour) and DPB (72-hour) countdown clocks for any
active breach incidents.

For DPO role users: surfaces the DPO Task Queue, listing all pending actions across

all modules sorted by urgency (Critical, High, Medium, Low), with inline
approve/reject capability.
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2. Consents

o Vishwaas Al Consents
ACME CORPORATION 9
Acme Corporation 2 2
98 Dashboard
PHASE 2
Consent ledger — —
© Purpose Catalog Tenant-wide consent events persisted in the append-only ledger with hash-chain non-repudiation. Click 46 Web, App, API Verifiable
any row to view full cryptographic proof and event history.
& Notices
<1 Campaigns
£ DPR Requests Recent events
Click any row to view DP details, cryptographic proof, and full event history
A Breaches
PRINCIPAL PURPOSE ACTION STATUS CHANNEL CREATED CHAIN HASH
B DPIAs
CUST-001 Analytics & Insights Withdrawn Withdrawn Web 16/03/2026, 20:21:56
& Vendors 7df13aec alytics
A Data Principals CUST-001 Service Delivery Withdrawn Withdrawn Web 16/03/2026, 20:21:50
7df13aec ervice_delivery
B DataMap CUST-006 Third-Party Sharing Granted Active Web 09/03/2026, 20:00:00
d1dd7a3 third_part
& Source Systems
CUST-004 Third-Party Sharing Withdrawn Withdrawn Web 09/03/2026, 19:30:00
51431931 third_party
%o Dashboard
CUST-005 Marketing Emails Granted Active Web 07/03/2028, 15:00:00
= Review Queue 6093829 it eme
@ Resolution Rules CUsT-003 Service Delivery Modified Active Api 07/03/2026, 14:30:00
taeabat service_deliver
~s:f[trust. ST-002 Research & Development Granted Active App 05/03/2026, 17:00:00

What it is

The Consents section is the central, immutable ledger of every consent decision made by
every data principal across all channels and campaigns.

What it does

* Displays a searchable, filterable list of all consent records: principal, purpose, status
(granted/withdrawn), channel, date, and language.

¢  Shows the full detail of any record including the exact notice text shown at the time
of consent, in the language the principal viewed it.

* Displays the SHA-256 hash, RSA digital signature, Merkle chain hash, and RFC 3161
trusted timestamp for each record — the cryptographic proof of non-repudiation.

® Provides a Chain Integrity Verification function that re-computes the entire Merkle
hash chain and confirms no records have been altered.

e Allows exporting the full consent audit trail as PDF or CSV, and individual records as
signed PDF or JSON artefacts for regulatory submission.

PAGE 6



Vishwaas Al | Product Feature Explanatory Document | Confidential

3. Purpose Catalog

o Vishwaas Al f—
Ao emmerae Acme Corporation 2.

Jo

Purpose catalog £ €017 puRbOSE
Cick a purpose to edit t, or create a new one on the right. Update consent purpose

Demo Eng egitimate imeests Acte X

Analyties & Insights coment Actve

Category Lawtul basis

v legitimate interests v

& Source systems. Marketing Emails

Marketing SMS coment Actve 385

Third-Party Sharing comemt Actve
& Dead Letter Queue THIR

& Propagation Webhooks
@ Cookie Banner

@ General

1 Reports

£ Users

What it is

The Purpose Catalog is where all consent purposes are defined and managed. Every
consent record in the system is tied to a purpose defined here.

What it does

* Lists all consent purposes with their name, category, lawful basis, status, and the
number of consents recorded against each.

® Allows creating a purpose with: a multiingual name and description (22 Indian
languages and English), category (Essential, Functional, Analytics, Marketing,
Third-Party Sharing, or Employment), lawful basis (Consent or Legitimate Use), data
categories, retention period, and linked processors.

® Provides a minor_restricted flag per purpose: when enabled, the API blocks consent
for this purpose from a minor principal unless guardian approval exists.

e Links purposes to privacy notices. Editing a published purpose triggers a re-consent
workflow for affected principals.
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4. Notices

© Vishwaas Al Notices
‘ i Acme Corporation 2 2

98 Dashboard

PHASE 3 @

All types Bl @ Create notice

D Consents . .

Privacy notices
© Purpose Catalog Manage multilingual notice versions, publish updates, and track deliveries across the tenant from a

single workflow.
i G NOTICE ACTIVE SRAFTS ]

7 5 1 40

£ DPR Requests
A Breaches
B DPiAs Notice catalog

Click a notice to open its editor, version history, and approval workflow
&, Vendors

NOTICE TYPE STATUS VERSIONS DELIVERIES UPDATED
A8, Data Principals

Retrospective Vendor Sharing Notice 2025 Retrospective BT v1current 0 17/03/2026, 18:27:00
8 DataMap
T — Marketing Notice Update Q2 2026 e e Vi current o FR—
2 Caarbaa Customer Collection Notice T T vicurrent i 17/03/2026, 18:27:00
“Z Review Queue as

Collestior active r eurrent 0 17/03/2026, 15:19:46

@ Resolution Rules

Demot Collectior active i\ Stireent 12 17/03/2026, 15:1512

A-_Moniter

What it is

The Notices section is where the organisation creates, versions, and manages its privacy
notices in compliance with Section 5 of the DPDP Act and Rule 3 of the DPDP Rules 2025.

What it does

Lists all notices with version number, status (Draft, Under Review, Published,
Archived), effective date, and linked purposes.

Provides a rich-text builder with tab-based multilingual authoring for all 22 Indian
languages and English simultaneously.

Supports three notice types: Collection Notice, Retrospective Notice (for pre-Act
legacy data under Rule 3), and Updated Notice.

Enforces a Rule 3 compliance checklist: all 7 required elements must be present
before the notice can be published.

Runs an approval workflow: Draft » Submitted for Review > Approved by Legal or
DPO - Published. Maintains full version history.

Tracks delivery per principal: records when each notice was served, via which
channel, and in which language.

Triggers re-consent campaigns automatically when a material change is made to a
published notice.
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b. Campaigns

o Vishwaas Al campaigns
Acme Corporation A 2
98 Dashboard
CONSENT COLLECTION
9 Consents N
Campaigns
© Purpose Catalo of n cam) . ncipals witt t
P 9 Create and launch consent collection campaigns. Send targeted emails to Data Principals with a portal All statuses v [p——
link to grant or withdraw individual consents.
B Notices
o rene oRaT COMPLETED
2 0 2 0

2 DPR Requests

& Breaches
B DPIAs
s

> Vendors

A, Data Principals

B DataMap

¢ Source Systems

%o Dashboard

Campaign catalog

Click a campaign to view delivery analytics and launch controls.
CAMPAIGN TYPE STATUS CHANNELS DELIVERIES LAUNGHED

ﬂ‘fl initial_collection draft email, in_app 0 Scheduled 17/03/2026

Demo Consent Campaign initial_collection draft email, in_app 0 Scheduled 17/03/2026

Z= Review Queue

€ Resolution Rules

What it is

Campaigns is where the organisation runs structured consent collection drives — the
primary mechanism for obtaining DPDP-compliant consent at scale, including retrospective
consent for pre-Act data under Rule 3.

What it does

Lists all campaigns with status (Draft, Pending DPO Approval, Approved, Running,
Completed, Cancelled), audience count, channel, and response metrics.

Allows creating a campaign with: a linked published notice, selected purposes,
audience (all principals, those without consent for selected purposes, a custom
segment, or an uploaded list), channels (Email, SMS, or both), token expiry period,
and an optional schedule.

Requires DPO approval before dispatch. The DPO can preview the exact notice and
purpose cards the recipient will see before approving, in any of the 22 supported
languages.

On execution, generates one unique single-use personalised link per principal and
dispatches it. The link opens a branded consent page the principal can act on
without logging in.

Shows live execution progress: tokens generated, dispatched, delivered, opened,
and responded. Provides per-campaign analytics: response funnel, per-purpose
consent rate, per-channel performance.

Supports automatic re-send to non-responders after a configurable number of days.

PAGE 9



Vishwaas Al | Product Feature Explanatory Document | Confidential

6. DPR Requests

@ ViShWaaS A| DPR Requests
ACME CORPORATION . °
Acme Corporation A
98 Dashboard
RIGHTS MANAGEMENT
9 Consents PR .
Data Principal Rights
© Purpose Catalog Process access, correction, erasure, grievance, nomination, and consent withdrawal requests. SLA: 90 & Refresh
days per DPDP Act Section 12
B Notices
< Campaigns
TOTAL REQUESTS OPEN REQUESTS SLA OVERDUE COMPLETED THIS MONTH
P> DPRRequests
A Breaches
B DPIAs
& Vendors All statuses v All types ~  [] overdue only
£, Data Principals
REQUEST TYPE STATUS PRIORITY PRINCIPAL LA ASSIGNEE
8 DataMap

& Source Systems

%o Dashboard
“= Review Queue

€ Resolution Rules

DPR-2026-00004

DPR-2026-00006

DPR-2026-00002

Grievance

Access

Erasure

Nomination

© Awaiting Response

& In Progress

© Completed

CUST-003

CUST-006

CUST-004

CUST-001

& Overdue 6d

& Overdue 3d

@ 44d left

Ac_Monitor.

DPR-2026-00005

What it is

DPR Requests is the workflow management centre for all Data Principal Rights requests:
Access, Correction, Erasure, Nomination, Grievance, and Portability.

What it does

Lists all requests with reference number (DPR-YYYY-NNNNN), type, principal,
submission date, status, assigned staff, and colour-coded SLA deadline indicator.

Manages each request through a structured workflow: Submitted = Identity
Verification - In Progress > Pending Approval » Completed / Rejected / Escalated.

For erasure requests: runs an automatic Data Footprint Pull (showing every
connected system where the principal’s data exists) and a Legal Hold Check
(identifying what can be erased vs what must be retained by law, citing the specific
statute). Staff must acknowledge legal hold findings before erasure jobs are created.

Creates per-system erasure jobs, dispatches cessation instructions to external
processors, and generates an Erasure Certificate PDF on completion.

For portability requests: packages the principal’s data from all connected systems
into a structured downloadabile file with a time-limited secure link.

Sends a tokenized 48-hour pre-erasure notification before deletion begins, allowing
the principal to choose to keep their data or proceed — without logging in.

Allows the DPO to escalate unresolved grievances to the Data Protection Board.
Sends SLA breach alerts automatically to assigned staff and the DPO.
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/. Breaches

© Vishwaas Al Breaches
ACME CORPORATION . °
Acme Corporation A 2
85 Dashboard
Breach Management P S——
Incident intake, assessment, DPBI notification — DPDP Act Section 8(6)
7y Consents
© Purpose Catalog TOTAL INCIDENTS OVERDUE DPB CRITICA OPEN
B Notices 3 1 1 2
<1 Campaigns
Fo DPR Requests All Statuses v~ AllSeverities v O Refresh
INCIDENT CATEGORY SEVERITY STATUS AFFECTED DPBI 72H REPORTED
B DPIAs
Phishing @ Critical © Reported 1,200 09 Mar 2026 w >
2 Vendors Phishing Attack — Customer Support Staff nishin Critica Bl Viex
A Data Principals
Third A Mediu 800  On time 8 Feb 2026 ow >
Third-Party Marketing Platform Data Leak " ot ontime View
8 Data Map Unauthorized Access to Customer Analytics D. Unauthorized Access O High ® Closed 3,400 v On time. eb 2026 View >
© Source Systems
% Dashboard
= Review Queue
& Resolution Rules

What it is

Breaches is the incident management centre for personal data breaches, covering the full lifecycle
from intake to closure.

What it does

Lists all incidents with reference number (BRI-YYYY-NNNNN), type, severity, status, CERT-In
notification status, DPB notification status, and date reported.

The Report a Breach button is available in the top navigation for all admin roles at all times.
The intake form captures: discovery timestamp, breach type, affected systems, affected
data categories, estimated principals, and immediate containment actions.

On submission, two regulatory clocks start simultaneously and are displayed as live
countdowns: CERT-In clock (6-hour deadline under Rule 7) and DPB clock (72-hour deadline
under Section 8(6)). Both change colour as deadlines approach and send escalation alerts
at defined thresholds.

CERT-In and DPB notification workflows are each a multi-step process: auto-generated draft
- DPO review and edit » DPO approval » mark as submitted with reference number entry »
clock freezes showing submission timestamp.

Principal notification composer is pre-filled from the impact assessment, requires DPO
approval, and dispatches a unique tokenized link per affected principal to a branded breach
notification page (no login required).

Tracks remediation actions with owners, deadlines, and evidence uploads. Incident cannot

be closed until all remediations are complete. Generates a Breach Closure Report PDF on
closure.
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8. DPIAs

o Vishwaas Al DPIAs
ACME CORPORATION .
Acme Corporation A &
98 Dashboard
DPIA Assessments P —
Data Protection Impact Assessments — DPDP Act Section 10 (Significant Data Fiduciaries)
9 Consents
© Purpose Catalog TOTAL DPIAS PENDING REVIEW APPROVED CRITICAL RISK
B Notices 7 1 4 0
<1 Campaigns
FPo DPR Requests AllStatuses v All Types v O Refresh
A\ Breaches
ASSESSMENT PROCESSING TYPE sTATUS RISK LEVEL RISKS CREATED
B DPIAs
ren's Data ® Dra ] 2 Mar 2026 W
 vendors forgt Children's Dat; Draft View >
R, Data Principals
i Children's Data QA vod s
validate on \PProve: View
B DataMap testss New System © Approved o View >
¥ Source Systems
verifytest New System © Approved 0 Mar 2026 View >
%o Dashboard s ® o 10 Mar 2026
" . Children's Data © Draf o 0 Mar 2026 2w >
Minor User Data Processing e e e ¢ Vie
= Review Queue
. Cross-Border Transfer © Pending Review o 0 Mar 2026 View >
@ Resolution Rules Cross-Border Data Transfer to SendGrid o Border Transie wnding Reve ‘ !
High-Risk Profiling © Approved High z 0 Mar 2026 View >

Customer Behavioral Analytics Pipeline

What it is

DPIAs manages Data Protection Impact Assessments — mandatory evaluations before
initiating high-risk processing activities, required for Significant Data Fiduciaries.

What it does

e Lists all DPIAs with title, linked processing activity, risk score, risk level
(Low/Medium/High/Critical), status, DPO approval status, and next review date.

e Provides a step-by-step guided questionnaire covering processing description, data
categories, volume, necessity and proportionality, and risk identification.

e Auto-calculates a risk score 0-100 based on data sensitivity, volume, processing
nature, and impact potential.

¢ Provides a structured risk registry with likelihood, impact, and planned mitigation per
identified risk. Tracks mitigation implementation with assigned owners and
deadlines.

¢ Routes completed DPIAs through a DPO approval chain. Displays a radar chart for

risk dimensions and generates a printable DPIA Report PDF for Board or auditor
submission.
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0. Vendors

g Vishwaas Al DPIAs
ACME CORPORATION q
Acme Corporation A &
98 Dashboard
DPIA Assessments P ——
Data Protection Impact Assessments — DPDP Act Section 10 (Significant Data Fiduciaries)
9 Consents
© Purpose Catalog TOTAL DPIAS e APPROVED CRITICAL RISK
B Notices 7 1 4 0
<1 Campaigns
Po DPR Requests AllStatuses v All Types v O Refrest
£\ Breaches
ASSESSMENT PROCESSING TYPE sTATUS RISK LEVEL RISKS CREATED
B DPlAs
hildren's Data O©Dra 0 '
@ Vendors fergt Children's Dat Draft View >
R, Data Principals
validate Children's Data © Approved 2 026 View >
a New System © Approved 0 oW >
B DataMap testss PPr View
& Source Systems
verifytest New System © Approved 9 Mar 2026 View >
Ro Dashboard Children's Data ©Draft o 10 Mar 2026 ow >
Minor User Data Processing ° o ’ View
7= Review Queue
Cross-Bo r Transfer @ Pending Review 0 0 Mar 2026 W >
@ Resolution Rules Cross-Border Data Transfer to SendGrid foss Border Transte LU ‘ Vie
High-Risk Profiling @ Approved High 2 0 Mar 2026 View >

Customer Behavioral Analytics Pipeline

What it is

Vendors is the organisation’s data processor registry for onboarding, assessing, and
continuously monitoring all third-party vendors who process personal data on the
organisation’s behalf.

What it does

¢ Lists all vendors with name, type (Processor/Sub-Processor/loint Controller),
country, risk level, DPA status, DPA expiry date, and lifecycle status.

¢ Allows generating a DPDP-compliant DPA from a built-in clause library (required
clauses locked, optional clauses togglable), previewing the full document, and
dispatching for e-signature via Leegality. DPA activates automatically when both
parties sign.

e Automatically flags vendors outside India as cross-border transfers and checks the
destination country against the government restricted country list.

® Manages cessation instructions: when a principal withdraws consent for a purpose
shared with a vendor, a cessation instruction is auto-created, dispatched to the

processor liaison, and tracked through acknowledgement and confirmation.

e Sends DPA expiry alerts. Manages vendor lifecycle: Pending Review > Approved -
Active > Suspended > Terminated.
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10. Data Principals

o VemesA

98 Dashboard

) Consen ts

©@ Purpose Catalog

B Notices

<1 Campaigns

P DPRReque:

&\ Breaches

B DPIAs

& Vendors

R Data Principals

B Datamap

data-principals

Jo

Acme Corporation

DATA UNIFICATION
A, Data Principals
Canenical consumer identities — consolidated across all source systems.

Total Principal

6

sts

All Status v All Unification v All Sources > Newest first v O Minors

IDENTITY STATUS UNIFICATION CONSENT HEALTH DPRS UPDATED

CUST-006 BN o Active @ Single source 6 1

CUST-005 O Mino

o Active single source 3

CUsT-004 ® Active single source 620 1

&  Source Systems

%e Dashboard

= Review Queue

@ Resolution Rules

CUST-003 TA * Active

CUST-002 HI

® Active

CusT-001 ® Active

ing 1-8 of 6 pr

What it is

Data Principals is the organisation’s unified registry of all individuals whose personal data is
held and processed — customers, users, employees, or any other individuals.

What it does

Lists all principal records with name, email, consent status summary, minor flag, and
last activity date.

Each record shows: full profile, identity graph (external IDs across all connected
systems), consent decisions per purpose, rights request history, and complete
activity timeline.

Shows the data footprint: every system holding data for this individual, data
categories held per system, and the responsible processor.

For minor principals: shows the is_minor flag, age verification method, guardian
email, and per-purpose guardian consent status. Allows sending a guardian consent

request directly from the record.

Allows staff to submit a rights request on behalf of a principal, manually flag a
principal as a minor, and link a guardian.
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DATA SYSTEMS

1. Data Map

o) Vishwaas Al T
ACME CORPORATION . o
Acme Corp! a4 o)
Vishwaas Al Privacy & Consen
98 Dashboard
! ' ADMIN MODULE
B Add System
£) Consents Data Map
@ Purpose Catalog Systems, processing activities, data categeries, retention periods, and risk exposure.
B Notices
fo=)
8 & @ =)
<1 Campaigns
£ DPR Requests ) .
Total Data Assets Critical / High Risk Cross-Border Transfers Unencrypted at Rest
& Breaches
B DPiAs
Vs @ crtcal  Hish  Medum  Low (O Cross-borderonly
& Vendors
. On-Premise | e Critical | & Unencry ypted >
R Data Principals Select an asset
HR Information System
©Employee Pl ©Salarydata  ©Health records  © Biometrics
B DpataMap 2 Y

& Source Systems
Internal High >

Core Database (PostgreSQL)

o Dashboard
©Name ©OEmail ©Phone  ©Aadhaar (enerypted)

2= Review Queue

Saa$ | Third-part * High @ Cross-border
& Resolution Rules (UL J

Email Marketing Tool

What it is

The Data Map is the organisation’s visual Record of Processing Activities (RoPA) — an
interactive diagram showing how personal data flows between all internal systems and
external processors.

What it does

®* Renders an interactive diagram with internal system nodes and processor nodes.
Edges show data flows labelled with data categories. Cross-border transfer edges
are visually distinct.

® Clicking any node opens a detail panel: name, data categories, DPA status. Clicking
any edge shows data categories flowing, transfer mechanism, DPA status, and
blacklist check result.

¢ An Open Gaps panel automatically identifies compliance discrepancies: assets with
Nno processing activity, activities with no lawful basis, processors with no active DPA,
unregistered cross-border transfers, purposes with no linked notice, and
uncategorised data categories. Each gap has a Resolve button navigating directly to
the fix.

e The gap count feeds into the Compliance Score. Allows exporting the full RoPA as
PDF, CSV, or JSON.
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12. Source Systems

© Vishwaas Al source-systems
Lcme corroRaTon Acme Corporation Ja

Jo

88 Dashboard

DATA UNIFICATION + Add New
2 Consents Source Systems

Register and manage external systems that hold Data Principal PI

© Purpose Catalog
B Notices . - e . B o
< Campaigns 2 0 0 0
S DPR Requests

& Breaches Al Types v Alstatus v
DPIAS

QA salesforce Test Draft ¢ Salesforce Production Draft

&
& Vendors
2

, Data Principals

B DataMap

¢ Source Systems

%o Dashboard

CSV Import Sources
Create a source system with CSV Import integration method to upload customer data files. Click Upload €SV on an active CSV source to start ingestion. Sample files are in crosstrust/samples/csv/

Y= Review Queue

& Resolution Rules

Ar_Monitor

What it is

Source Systems is where Vishwaas Al is connected to all external applications and
databases holding personal data — the foundation for the identity graph, data discovery,
RoPA population, and consent propagation.

What it does

¢ Lists all connected systems with type, connection status, last sync timestamp, and
principal record count.

e Supports pre-built connectors for: Salesforce, HubSpot, Shopify, CleverTap,
Freshdesk, Darwinbox, PostgreSQL/MySQL/MongoDB, AWS S3/Azure Blob/GCS,
and a generic REST/GraphQL connector for any custom API.

e On connection, triggers an automated PIl Discovery Scan identifying all personal
data fields and categorising them by type.

e Maintains continuous real-time or scheduled sync after initial connection. Allows
configuring connector-specific actions — the native system commands triggered
on consent changes (e.g. DoNotEmail flag in CRM, unsubscribe in email marketing
platform).
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DATA UNIFICATION

13. Dashboard (Data Unification)

Vishwaas Al acme-corp > Admin > unification > Dashboard
ACME CORPORATION s -
Acme Corporation g 2 >
Vishwaas Al Privacy & Consent Management
98 Dashboard
DATA UNIFICATION
. . > Run Resolution Now = View Review Queue & Export Stats
9 Consents Identity Resolution Dashboard
© Purpose Catalog Monitor how Data Principals are unified across source systems.
B Notices
Canonical Profiles 2 Unified {Multi-source) %o Pending Review = Avg Sources | Profile =

<1 Campaigns

9% DPRRequests :
A Breaches
DPIA: . . . S .
8 N Staging Records by Resolution Status Profile Distribution
& Vendors

A Data Principals

B DataMap

& Source Systems

Z= Review Queue

© Resolution Rules

What it is

The Data Unification Dashboard provides an overview of the identity resolution process —
how Vishwaas Al matches and merges records about the same individual from multiple
connected systems into a single unified Data Principal profile.

What it does

@ Displays summary metrics: total principals identified, matches confirmed, matches
pending manual review, and duplicates flagged.

e Shows trends in match rates and resolution queue volume over time, with a
breakdown by match type: deterministic (exact match on email, phone, Aadhaar
hash, PAN, customer ID) versus probabilistic (fuzzy Jaro-Winkler name and address
matching).
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14. Review Queue

@ Vishwaas Al reviow-queue
Acme Corporation A &
88 Dashboard
DATA UNIFICATION pa——
5]
8 consents Manual Review Queue
@ Purpose Catalog Resolve ambiguous identity matches that require human judgement.
& Notices Sort: Confidence v All Sources v Al Methods v
<1 Campaigns
£ DPRRequests
& Breaches

B DPIAs

A, Data Principals

B DataMap

© Source Systems

%o Dashboard

Y= Review Queue

& Resolution Rules

What it is

The Review Queue is where Privacy Managers act on probabilistic identity matches the
system could not confirm automatically — cases where two records are likely the same
person but require human judgement.

What it does

* Lists all pending matches with: the two records being compared, confidence score,
matching fields (name, DOB, address fragments), and source systems.

¢ For each match, shows both records side by side. The reviewer can Confirm
(merging into one unified profile) or Reject (keeping as separate individuals,
preventing future matching of this pair).

¢ Every decision is written to an immutable merge audit trail with: reviewer identity,

timestamp, records involved, and confidence score. Allows bulk assignment of items
to staff members.
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15. Resolution Rules

3 Dashboard

DATA UNIFICATION

< Dashboard &
D Consents Resolution Rules
C atch sholds and auto-link rules for identity resolutio
© Purpose Catalog Configure matching thresholds and auto-link rules for identity resolution.
B Notices O Rules are read-only for your role. DPO or higher is required to create or modify rules.
<1 Campaigns
£ DPR Requests
— 100% _
& Breaches Email Exact Match Determinis tic Email ©] ]
B DPiAs
Phone E.164 Match h oo © @
9 vendors one E. atcl Determinis tic Phone ©
A, Data Principals 100%
Aadhaar Hash Match Deterministic Aadhaar ] @
B DataMap — 100% .
PAN Exact Match Deterministic PAN © @
& Source Systems
. — 95%
Name + DOB + City Fuzzy Probabilistic Name + DoB + City ()
%o Dashboard
) - 95%
%= Review Queue Name + Phone Partial + Address Probabilistic Composite (@]
& Resolution Rules
. . — 95% o)
Email Deterministic Match Deterministic Email ©] (@]
A Meniter -— 98%
QA Email Match Rule Deterministic Email @

43 Dead Letter Queue

What it is

Resolution Rules is where administrators configure how the identity resolution engine
behaves — which fields are used for matching, what confidence thresholds trigger
automatic vs manual review, and how cross-system data conflicts are resolved.

What it does

¢ Configures deterministic matching fields: which fields across connected systems
are treated as definitive identifiers.

¢ Sets probabilistic matching thresholds: the confidence percentage above which a
fuzzy match is auto-confirmed, and the range that routes to the manual Review

Queue.

¢ Defines conflict resolution priority: when connected systems have conflicting values
for the same field, which system is the source of truth.
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CONSENT PROPAGATION

16. Monitor

98 Dashboard

CONSENT PROPAGATION

2 Consents Propagation Monitor
© Purpose Catalog Real-time delivery stats, latency metrics, and downstream app breakdown.
& Noti
< [©] ©] A
< Campaigns
£, DPRRequests 0 100% 0 0

Total Dispatched Delivered Retrying | Pending Dead Letter

Delivery Volume — Last 24h
Hourly breakdown by delivery status

AR, Data Principals

B DataMap

& Source Systems k);%

%o Dashboard
= Review Queue

@ Resolution Rules

& Dead Letter Queue

By Downstream Application

What it is

The Monitor is the real-time view of consent propagation — the process by which consent
decisions are automatically communicated to all downstream connected systems. When a
principal grants or withdraws consent, Vishwaas Al instructs every connected system to act
onit.

What it does

¢ Displays a live feed of all propagation events: principal, purpose, event type
(grant/withdrawal), target system, delivery status (delivered/pending/failed), and
timestamp.

e Shows aggregated metrics: total events in a period, delivery success rate, and failed
deliveries. Allows filtering by system, event type, status, and date range.

* Allows manual retry of failed events. Provides a drill-down showing the full payload
sent and the response received from the target system.
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1/. Dead Letter Queue

o Vishwaas Al dead-letter
rome corperaTon Acme Corporation Jad

Yo

88 Dashboard

CONSENT PROPAGATION
8 Consents Dead Letter Queue

Inspect and retry failed webhook deliveries that exceeded all retry attempts

& Refresh

© Purpose Catalog
B Notices

<1 Campaigns

£, DPR Requests
& Breaches

@ DPIAs Dead \enerqueuelsem?w

jebhook deliveries have been succe

& Vendors

R, Data Principals

B DataMap

% Source Systems

% Dashboard
= Review Queue

@ Resolution Rules

What it is

The Dead Letter Queue holds consent propagation events and webhook deliveries that
have persistently failed after all automatic retry attempts (three retries with exponential
backoff).

What it does

® Lists all failed events with: event type, target system or webhook endpoint, number
of retries, last error message, and original timestamp.

e Allows reviewing the full payload and error history per event. Supports manual retry
of individual events or bulk retry after resolving the underlying issue.

e Allows permanently dismissing an event with a recorded reason when delivery is no
longer required or possible.
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SETTINGS

18. Propagation Webhooks

© Vishwaas Al acme-corp » Admin > Settings -~ propagation
ACME CORPORATION Acme Corporation Ja

Vishwaas Al Privacy & Consent Management

Jo

98 Dashboard

D Consents Propagation Webhooks

© Purpose Catalog Register downstream applications to receive real-time consent change events.

B Notices Registered Webhooks
Each webhook receives HMAC-signed POST requests for subscribed events
<1 Campaigns

s DPR Requests

A Breaches

&S
B DrlAs
No webhooks registered
2, Vendors Click "+ Register New" to add your first webhook endpoint.
R, Data Principals + Register New
8 DataMap

© Source Systems L N
Connector-Specific Actions
Per-app purpose->action mappings defined in each downstream application's propagation config

%< Dashboard

Y= Review Queue

g 47

@ Resolution Rules

What it is

Propagation Webhooks is where the organisation registers external HTTP endpoints to
receive real-time notifications when compliance events occur in Vishwaas Al, enabling
connected systems to stay in sync without polling.

What it does

® Lists registered endpoints with URL, subscribed event types, status, and delivery
success rate.

e Supports 9 event types: consent.granted, consentwithdrawn, consent.expired,
dpr.request.created, dpr.request.completed, breach.reported, breach.dpbi_notified,
notice.published, and vendor.status_changed.

e Signs every outgoing payload with X-Vishwaas Al-Signature (HMAC-SHA256) for
authenticity verification. Retries with exponential backoff; persistent failures go to
the Dead Letter Queue.

¢ Provides a Test Endpoint function to verify connection and signature verification
before going live.
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19. Cookie Banner

@ Vishwaas Al Gl
M oRATIO . o
Acme Corporation IA )
88 Dashboard
PHASE 9
) Consents - -
Cookie Consent Widget
© Purpose Catalog Manage cookie categories displayed in your embedded banner. The banner collects visitor consent and 0 o -
syncs choices to the CrossTrust consent ledger
B Notices
<1 Campaigns
(@O Forbidden resource X
£ DPRRequests
&\ Breaches
@ DPIA:
@

x
o
k]
=l

YOUR_TENANT_SLUG

Cookie Categories + Add Category

%o Dashboard
= Review Queue

@ Resolution Rules

What it is

Cookie Banner is where the organisation configures the embeddable JavaScript cookie
consent widget for their website. All cookie consent decisions are recorded in the Vishwaas
Al consent ledger.

What it does

¢ Configures the banner appearance: position (bottom bar, top bar, or modal),
branding (logo, colour), and language behaviour.

e Provides a Cookie Scanner that discovers and categorises all cookies on the
website, mapping them to four categories: Essential (always on), Functional,
Analytics, and Marketing.

e Maps each cookie category to a consent purpose in the Purpose Catalog. Supports
all 22 Indian languages and English with browser language auto-detection.

e Generates the embed code (a single script tag) for the organisation’s website.

Configures the three DPDP-required action buttons: Accept All, Accept Selected,
and Reject All. Provides a Preference Centre reopener for returning visitors.
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20. General

© Vishwaas Al

oN
88 Dashboard

Consents

Purpose Catalog

B/ o O

Notices

1\

Campaigns
P DPR Requests
& Breaches
B DPIAs
2. Vendors

AR, Data Principals

B DataMap

& Source Systems

%o Dashboard
%= Review Queue

% Resolution Rules

What it is

Settings

Acme Corporation

ADMIN MODULE

Settings

Tenant profile, authentication policy, SM

@  SourceSystems

Tenant Profile

& Authentication Policy

B3 Email | SMTP

L Notifications

O Compliance Config

o® APIKeys
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P configuration, notifications, and API keys.

Tenant Profile

egal entity name, contact details, and DPDP

Organisation Name

Acme Corporation

Primary Domain

acme-corp.test

DPBI Registration ID

DPBI-2025-AC-0042

Significant Data Fiduciary (SDF)
SDF obligations inc D

egistration information.

de mandatory DPO appointment, annual DPIA

DPO Email Address

dpo@acme-corp.test

Tenant Slug

Subscription Plan

Jo

General Settings is the central configuration area for the organisation’s Vishwaas Al tenant,

covering the organisation profile, portal branding, user management, and API access.

What it does

Organisation Profile: legal name, DPBI registration ID, SDF flag, industry, default
language, timezone.

DPO and Grievance Officer: name, email, and contact details, displayed in the portal
and in all regulatory notifications.

Portal Branding: logo, brand colours, custom domain for the Data Principal Portal,
with live preview.

User Management: create, update, and deactivate internal users. Assign from 11
system roles. View login history per user.

API Keys: create, view, and revoke scoped API keys for system-to-system
integration.

Embed Codes: generate consent widget and DSAR submission form embed codes
for the organisation’s website.

PAGE 24



21. Reports

g Vishwaas Al P A Reports
ACME CORPORATION Acme Corporation
Vishwaas Al Privacy & Consent Management

98 Dashboard

PHASE 8 — ANALYTICS & REPORTING

3 Consents Compliance Reports

® Purpose Catalog
tenant and include audit metadata.

& Notices
<3 Campaigns

£ DPR Requests 1. Select Report Type

& Breaches © ConsentSummary
All consent records, purpose breakdown,
B DPiAs integrity

% Vendors
@ Breach Incident Log

o
R Data Principals

[y VendorRegister
B8 DpataMap Data pi sors, Su
transtes

&  Source Systems

All breach incidents, DPBI notification timelines, sever

opt-in rates, hash chain

ty analysis

Vishwaas Al | Product Feature Explanatory Document | Confidential

ANALYTICS

Generate and export DPDP Act compliance reports in PDF, CSV, or Excel. All reports are scoped to your

Generation Queue
Reports generated this session

DPR Status Report
Data Principal Rights requests, SLA compliance, resolution times by
type

DPIA Register
Data Protection Impact Assessments, risk scores, approval status

Audit Trail Export
Complete hash-chained audit log, immutable event ledger, chain

Report Catalog

%o Dashboard

© Consent Summary
B Compliance Posture Report
End-to-end DPDP Act compliance across all modules with

remediation checklist [@ DPR Status Report

= Review Queue

@ Resolution Rules

Breach Incident Loy
1) 9

2. Qutput Format & Date Range
[ DPIARegister

What it is

Reports provides on-demand and scheduled compliance reporting for internal governance,
Board submission, regulatory inspection, and legal defence.

What it does

Generates on-demand reports in PDF and Excel: Compliance Summary, Consent
Audit, DPR Summary, Breach Report, Vendor Compliance, and Training Completion.
All reports are filterable by date range.

Schedules automated weekly or monthly report delivery by email to configured
recipients.

Generates a Board of Directors Report for SDF tenants, formatted for executive
audiences.

Generates a DPB Investigation Pack: a formal, bookmarked, multi-section PDF
evidence bundle structured by DPDP Act section, assembling evidence from all
modules into a single indexed document with a cryptographic audit chain
verification result. Used when the organisation is under DPB investigation.

All generated documents are watermarked, date-stamped, and attributed to the
generating user.
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22. Users

c] Vishwaas Al users

neME coRRORATIO Acme Corporation AL 2
88 Dashboard

User Management

3 . Manage portal users, assign roles, and control access within your organisation
3 Consen s
© Purpose Catalog TOTAL USERS ACTIVE macTIvE ROLES INusE
B Notices 0 0
< Campaigns
9, DPRRequests ® Forbidden resource
!
& Breach

All Statuses v AllRoles v O Refresh

A, Data Principals

B Data Map No users yet
©  Source Systems + Add First User

%o Dashboard
Yz Review Queue

% Resolution Rules

What it is

Users provides a view of all admin users active in the tenant, their roles, account status, and
activity history.

What it does

¢ Lists all admin users with name, email, assigned role(s), account status, last login,
and MFA status.

¢ Allows creating new users by entering name, email, and assigning one or more of the
11 system roles. Allows editing roles and deactivating accounts. Deactivated users

cannot log in; their historical actions remain in the audit trail.

¢ Displays the login audit trail for any user: every login attempt with IP address, device,
and timestamp. Shows a summary of recent activity per user.
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23. Training

g Vishwaas Al Training

8

©

B8 DataMap

@

%e Dashboard

Purpose Catalog

Data Principals

Source Systems

oN

1)

Acme Corporation A

DPR Requests

ADMIN MODULE )
X - D> Assign Courses
Privacy Training
Course catalogue, assignment tracking, completion rates, and department coverage.
< © © m
81% 85% 7 6
Overall Completion Mandatory Completion Overdue Assignments Active Courses
Department Coverage
Compliance | | Mandatory Engineering
DPDP Act 2023 — Foundations Marketing
An overview of India’s Digital Personal Data Protection Act, key definitions, fiduciary obligations, and penalties.
Legal
0% CGustomer Support
Finance
HR
Compliance Mandatory
Consent Management & Withdrawal
= Review Queue Purpose-specific consent, affirmative opt-in requirements, withdrawal mechanisms, and legitimate use exceptions.

& Resolution Rules

Recent Completions

Vikram Mehta 92%

What it is

Training is the privacy awareness e-learning platform for internal staff, covering course

assignment, completion tracking, certification, and policy acknowledgement.

What it does

Provides a library of pre-built privacy courses covering: the DPDP Act, consent
handling, breach response, data rights, and children’s data protection. Supports
role-specific tracks for IT, HR, Marketing, Legal, and Leadership.

Allows creating custom courses with text modules, video, and resources. Each
course has a configurable MCQ assessment, passing score threshold, and
certificate validity period (default 12 months).

Assigns courses to individual users, departments, or roles with a due date. Staff take
courses module by module, complete the assessment, and receive a downloadable
certificate PDF automatically on passing.

Displays a completion dashboard by course, department, and user for audit
submission. Sends reminders for overdue assignments. Handles certificate expiry
and re-assignment for mandatory courses.

Policy Acknowledgement workflow: publish a policy, assign to staff, staff

acknowledge by clicking confirmation. Creates a non-repudiated record with user
identity, policy version, timestamp, and IP address.
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Part 2 — Data Principal Portal

The Data Principal Portal is the self-service interface for individuals to manage their privacy
preferences with the organisation. It is fully white-labelled with the organisation’s branding,
available in all 22 Indian languages and English, fully mobile-responsive, and accessible at

the organisation’s configured portal domain.

24. Portal Login

The Portal Login screen displays the organisation’s branding (not Vishwaas Al branding).
The data principal enters their email address and receives a 6-digit OTP. No password is
required or stored. On successful verification, the principal is directed to their My Consents

dashboard. After 5 failed OTP attempts, the account is temporarily locked.
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25. My Consents

© Vishwaas Al Consents
bR raRAL Data Principal Portal o o
Manage your consents, data rights requests, and privacy notices

<) Portal Login

) My Consents
PREFERENCES CENTER

D Requests My consents

B Notices Review purpose-by-purpose permissions, switch your display language, and update consent choices with

append-only ledger entries, English v

@ Cookie Settings

Granted Withdrawn Portal language

4 3 English

Demo Eng functional Pending Grant consent
Purpose code: demo newletter | Lawful basis: legitimate_interests

Latest action: pending

© View notices

Service De||very essential Withdrawn Grant consent
Purpose code: service_delivery | Lawful basis: contract

Latest action: withdrawn on 16/3/2026, 8:21:50 pm

What it is

My Consents is the primary screen of the Data Principal Portal. It gives the principal a
complete view of all consent purposes and allows them to manage each one individually.

What it does

¢ Displays one card per consent purpose: purpose name in the principal’s selected
language, a plain-language description, data categories involved, retention period,
and current status with an ON/OFF toggle.

® Each toggle change takes effect immediately and is recorded in the consent ledger
with a cryptographic hash. Each card links to the exact notice version shown at the
time consent was originally given.

®  Provides a Withdraw All Consents action with a confirmation dialog.

e For minor principals: all non-Essential toggles are disabled and labelled “Consent
managed by your guardian.”

e Shows a notification when any consent is approaching expiry, with a Renew option.
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20. Requests

© Vishwaas Al

TA PRINCIPAL PORTAL

=) Portal Login

2) My Consents

&) Requests

B Notices

@ Cookie Settings

What it is

Requests

Data Principal Portal

Manage your consents, data rights requests, and privacy notices

RIGHTS REQUEST CENTER

Requests

Track access, correction, erasure, grievance, nomination, and consent withdrawal requests. Identity is already
verified through your OTP sign-in session.

Principal ID Language

CUST-001 English

DPR-2026-00007  submitted
CORRECTION | HIGH PRIORITY

Last name correction

profile

DPR-2026-00001  <completed

ACCESS | MEDIUM PRIORITY

Minimum 20 characters. Include enough detail for the grievance team to act.Describe what you need. The portal records

identity as verified through your OTP session and starts the response SLA immediately after submission.

Open requests

Jo

D New request

Submitted: 16/3/2026
SLA deadline: 14/6/2026
Identity verified: Yes

Submitted: 9/3/2026
SLA deadline: 7/6/2026
Identity verified: Yes

Requests is where data principals submit and track their formal rights requests: Access,

Correction, Erasure, Portability, Grievance, and Nomination.

What it does

¢ Lists all previously submitted requests with reference number, type, submission date,
current status, and SLA deadline.

e Allows submitting a new request by selecting the type and providing a description. A

reference number is generated and displayed immediately.

e Request detail view shows the full status timeline, any messages from the assigned
staff member, and downloadable documents (erasure certificate, portability data

package).

e Shows the Grievance Officer’'s name and contact details prominently in the
Grievance request flow.

PAGE 30



Vishwaas Al | Product Feature Explanatory Document | Confidential

2/. Notices

© Vishwaas Al Nofices
DATA PRINCIPAL PORTAL A 3
Data Principal Portal & &
Manage your consents, data rights requests, and privacy notices
=) Portal Login
B My Consents NOTICE CENTER
&) Requests Notices
Review the prvacy notices delvered o you. The portal preserves the defivered language while showing your
current portal preference for context.
@ Cookie Settings
Delivered notices Portal language Most recent delivery
12 English 17/3/2026
Demol v & Delivered in English
Demo1 | collection notice | status active Channel: email

Delivered: 17/3/2026, 3:14:53 pm
Acknowledge

& Delivered content snapshot

Demo1 - Explain what data is collected, why it is used, and how rights can be exercised.

EFFECTIVE FROM: 17/3/2026 EFFECTIVE UNTIL: OPEN ENDED PUBLISHED: 17/3/2026

What it is

Notices is the principal’s personal library of all privacy notices the organisation has delivered
to them.

What it does

¢ Lists all notices delivered to this principal: notice name, delivery date, channel, and
language.

e Allows reading the full text of any notice in the preferred language via the language
selector. Shows version history for each notice.

e Breach notification communications are accessible here after their tokenized link has
expired, allowing the principal to refer back to breach notifications at any time.

PAGE 31



Vishwaas Al | Product Feature Explanatory Document | Confidential

28. Cookie Settings

© Vishwaas Al cookies
DATA PRINCIPAL PORTAL 0 . pm .
Data Principal Portal s 2

Manage your consents, data rights requests, and privacy notices
=) Portal Login

&) My Consents
COOKIE PREFERENCES

D Requests Cookie Settings
T Notices Control which cookies are set in your browser when you visit this website. Essential cookies are always
enabled as they are required for the site to function. Your preferences are stored locally and synced to the Enlish
nglis v
@ Cookie Settings consent ledger. Y
Enabled categories Last updated Portal language
0 Not set English

What it is

Cookie Settings allows the principal to manage their cookie preferences from within the
portal at any time, without needing to revisit the organisation’s website.

What it does

¢ Displays the four cookie categories: Essential (always on, non-togglable), Functional,
Analytics, and Marketing, each with a description.

e Allows toggling Functional, Analytics, and Marketing categories individually, with
Accept All and Reject All shortcuts.

¢ Changes synchronise with the consent ledger and propagate to connected
systems. Shows the current preference state and when it was last updated.
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